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1 First steps in MAXQDA
Welcome to the MAXQDA Introduction!
To get the most out of this introduction, it is recommended that you carry out the steps on your own computer with
your own project data or with the provided.
As with all Windows programs you can start MAXQDA by double-clicking on the program icon. The MAXQDA logo
will appear briefly and then you will see the following start-up screen:

The start-up screen of MAXQDA

You have the option Create and open new project or Open existing project (A project is the basic unit in
MAXQDA just like a DOC/X file represents the work unit in word.)
You can enter your user name in the empty field of the dialog box. If you are working on a project with multiple
persons it is useful to credit the user in order to document who wrote a certain memo or created certain codes. The
different registered users will be saved by MAXQDA, accessible through a list at the top of the window.
You can now select that you would like to create and open a new project and confirm by clicking OK. A windows
file browser window will appear wherein you can enter a file name (e.g. "test project") and choose the folder where
you would like to save the project.
From the moment you start the program, MAXQDA will save every single step automatically, so you do not need to
regularly save your work, as you might do in other programs like Microsoft Word. It is still strongly recommended,
however, that you secure your project from time to time with the Backup project function in the Project menu. It
makes sense to keep the project name and add the given date (e.g. “test project 02-21-11”). This way you are always able to access earlier stages of your project.
Additional MAXQDA projects can be created by selecting Project > New project in the taskbar. You can create an
infinite number of projects.
A project consists of text groups, texts, codes, coded segments, memos, variables, text links, etc. Technically speaking, a project is administered as a single file (file extension MX4).
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All files in your project are saved in a single file. Project files are easy to trace with the MX4 extension. All relevant
documents can be secured by doing a simple backup of the project file!
The only exceptions to this rule are (1) image and PDF files that are larger than the set maximum file size (set under
Options in the Project drop-down menu), and (2) multimedia files. These files are then stored in the folder designated for external project files.

Opening a project last used in an older version of MAXQDA
When opening a project in MAXQDA10, it will automatically display only MX4 files. To open projects that were
saved in an older version of MAXQDA, you need to change the type of file it is searching for. To do so, simply click
on the arrow next to Files of type, and select the appropriate option.

Opening an existing MAXQDA project

The Desktop and windows in MAXQDA
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2 The Desktop and windows in MAXQDA
As soon as you have clicked Save in the windows file dialog, MAXQDA will open the new project “test project”
which, of course, holds no data. At the same time the “Tips and tricks” window will appear and give you a useful
piece of information about the program. If you do not wish to receive these tips, simply unclick the box in the bottom lefthand corner.
After closing the “Tips and tricks” window, you will notice that the user-interface is constructed just like the Windows programs you are used to. Similar to the Microsoft Office programs, the file name of the current project can
be found in the title bar.
Beneath the menu bar is a toolbar allowing quick access to the frequently-used program functions. To the right of
the toolbar you will find the Code bar, offering different functions for coding and editing the current text. Additional
toolbars can be activated by clicking on the Toolbars drop-down menu. All activated toolbars can be dragged and
moved.

The Toolbars “MAXQDA standard” and “Code” underneath the menu

Underneath the toolbar you will recognize the four main windows of MAXQDA. All four of them can be hidden (and
shown again) via the Windows menu or the toolbar
corners.

. You can resize the windows by dragging the

The four main windows of MAXQDA

The four main windows provide the following features:

 The “Document System“ (top left) displays all imported texts, images, and multimedia files in your project. All
your material is collected here and can be sorted into multiple texts.

Simple document import
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 The “Code System” (bottom left) consists of the category system with the created codes and subcodes, as well
as the number of administered code segments

 In the “Document Browser” (top right), one document from the “Document System” appears and can be
edited, which means that you can mark text segments, attach codes, or create memos. Georeferences are also
visualized in the Document Browser.

 The “Retrieved Segments” (bottom right) window allows you to look at a selection of coded segments that correspond to the activated documents and codes.
All windows grant you direct access to the management functions: simply right-click on the icon or directly into the
blank sections. Beneath the menu bar is a bar with quick buttons which allow you to access to frequently-used program functions.

Import and organization of documents
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3 Import and organization of documents
MAXQDA makes it easy for you to import and organized various types of documents, including text documents
(DOC/X, RTF, TXT), PDF files, and images (JPG, GIF). These texts can contain all sorts of objects, such as tables, pictures, graphics, etc. Text and images can also be pasted into documents already imported via the Windows clipboard.
The way to work with audio and video files in MAXQDA is described in chapter XX: Audio and Video Files.

3.1 Simple document import
With MAXQDA you can enter new texts, copy texts via the windows clipboard, or import documents as a file. In
most cases you will want to import an existing text file. These files can contain all sorts of objects, e.g. charts, pictures, graphics, etc.
Attention: When importing a text file into MAXQDA make sure that it is not open in another program (e.g. in
Word)!

Import via drag-and-drop
Importing documents in MAXQDA is intuitive and easy: simply drag as many files as you like from Windows Explorer
and drop them into the “Document System” window.

The main window of the “Document System”

Import via pop-up menu
You can also right-click on the
icon in the “Document System” window and select Import document(s) from the pop-up menu. The following file dialog allows you to select the text of your choice – strikingly similar to opening a file in Word.
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Documents can be imported by right-clicking on Documents and after that Import document(s)

Import via the menu “Documents”
You can also import documents by selecting “Import document(s)” from the “Documents” drop-down menu:

Import documents via the MAXQDA menu

Visualization of documents
In MAXQDA 10, it is now possible to import graphics and image files into the Document System and organize them
as you would text documents. Importing these image files is done just like you would import text documents. The

Import and organization of documents
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documents shown in the Document System are visualized with various symbols depending on the type of file. RTF
and DOC/X files are visualized with the
symbol.

symbol, PDFs are visualized with the

symbol, and pictures have the

By moving the mouse onto the name of a document you will see a tooltip which gives you information about the
size of the document, the author (the user that imported the text), the date of the import, the number of coded
segments, and the number of memos.

Tooltip

3.2 Opening a document for editing
In order to look at or edit a document, it has to be loaded into the “Document Browser” window first. There are
two possibilities to do so:

 Either double-click the name of the document in the “Document System” window (see fig.),

Texts can be loaded by double-clicking

 or right-click the name of the document and select the option Open document from the context menu.
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Opening a document for editing

Texts can be opened by right-clicking and chosing “Open document”

The opened document will be signified by a specific symbol (horizontal pen) in the “Document System” window.

Opened text signified by a horziontal pen: “Teresa”

After opening the text, you will see it in the “Document Browser” window. Appearing in the title bar behind the
word “Document Browser” will be the name of the text group and the current text. Immediately in front of the text
will be a column with the paragraph numbering.

Import and organization of documents
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Opened text in the “Document Browser“

Documents arrange themselves into a certain number of paragraphs. A paragraph equals a paragraph in Word,
meaning that every paragraph ends by pressing return. In other words, a paragraph represents the text in between
two paragraph breaks.
In front of the paragraph numbering column you will see a light-greyish column that is, for now, empty. Later on
this column will show the text memos. There is another empty, grey column that will later show your code segments. This column can also be moved to the other side of the text by dragging it with the left mouse button.

Opening texts in tabs
In MAXQDA10, it is now possible to open multiple texts in the “Document Browser”. Instead of double-clicking on a
text, right-click and select Open document in a new tab. Rather than replacing the document that was formerly
opened in the “Document Browser”, both documents will be in the window. You can toggle between the texts by
clicking on the appropriate tab.

Two opened tabs in the “Document Browser”

In the example above, two different documents are open, and “Joanna” is currently being displayed. Switch to the
other tabs by simply clicking on the name.
You can also open an entire document group or set in tabs by dragging the group or set onto the “Document
Browser” window.
Using tabs is especially helpful if you need to constantly switch back and forth between several documents or if you
have extremely large documents that take a while to load.

Working with PDFs
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3.3 Working with PDFs
In MAXQDA10 it is possible to import PDFs directly into your project just like you would with DOC/X or RTF files.

Opened PDF file in MAXQDA

There are, however, several differences in how you can work with the PDFs:

 The basic separation units with PDFs are pages instead of paragraphs.
 PDFs cannot be edited in the “Document Browser”. Entering Edit Mode (see 3.5) as you would do when working with RTF or DOC/X files is not possible.

 Some PDF files are simple “pictures” or scans of text. Text in this type of PDFs can only be coded as you would
code images.
Coding text within a PDF is very similar to doing so in any other text document; You can code as little as a single
character or as much as an entire page. PDF files, however, are broken up into units by page instead of by paragraph. Because the PDFs can't be split up into paragraphs, it is not possible for MAXQDA to differentiate between
paragraphs on the same page.
You will also notice that PDFs are not viewed as the other text files. When you double-click on a PDF in the “Document System”, the first page will appear in the “Document Browser”.
To move between pages, however, you will need to activate the Document navigation from the Toolbars dropdown menu. It looks like this:
The first four symbols are for navigating between pages.
takes you to the first page,
moves you up one page,
moves you down one page, and
moves you to the very last page.
You can also zoom in
the window horizontally

and out

, view the document in its original size

, or fit the entire document into the window

toggles “Continuous View” on and off for PDF files.
shows all bookmarks within a PDF document for quick navigation.

.

, change the view so that it fits

Import and organization of documents
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Tip 1: The zoom in and out functions in the “Document Navigation” toolbar can also be used to zoom in and out of
“normal” non-PDF documents.
Tip 2: If you are using a mouse with a wheel, you can hold the Alt key and use the wheel to jump between pages of
a PDF.
Tip 3: You can also zoom in and out with the mouse wheel by holding the Ctrl key.

3.4 Organizing documents in document groups and sets
In principle, document groups function like folders in Windows Explorer. To create a new document group, right
click Documents in the “Document System” window and select New document group. MAXQDA will always
suggest a name: Group 1, Group 2, Group 3, etc. You can accept this suggestion or, even better; choose a more
meaningful name. For this tutorial you should call your first text group “New York.”
It is possible to rename your document groups at any time by right-clicking on an existing text group and selecting
the option Rename document group. There is no restriction on the number of document groups in MAXQDA.
In the aforementioned step you created a document group; now you will be able to insert texts into this text group.
To do this, right-click the concerned document group ("New York", in our example) and select the command Import document(s) from the menu. You will find the sample texts in the following program folders:

 Windows XP: My Computer > Shared Documents > MAXQDA10
 Windows Vista: Desktop > Public > Public Documents > MAXQDA10
 Windows 7: Libraries > Documents > Public Documents > MAXQDA10
After importing, you can open each document by simply double-clicking on it. The document will now be available
in the “Document Browser”. RTF and DOC/X files can be edited in MAXQDA by opening the concerned text and
pressing the Edit Mode on/off symbol

in the coding toolbar. Then you can change, edit, or add to your text.

Imported documents in the “Document System“

MAXQDA makes it possible for you to create “document sets,” which act as temporary groupings of documents
from various document groups. A set is only made up of links to the documents and does not actually cause documents to be duplicated. To create a new set, right-click on the “Sets” icon in the Code System and select “New
set.“
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Transcribing/writing text directly in MAXQDA

New sets can be created via right-click

Tip: If documents are activated when you choose to create a new set, these activated documents will automatically
be added to the set.
You can then give the new set a name (e.g. married male interviewees). Any set can be edited or added to by dragging new documents into it or right-clicking on a document already in the set and choosing to delete it from the set.
Sets remain available to you until you choose to delete them by right-clicking on them and selecting Remove set.

Created document set

3.5 Transcribing/writing text directly in MAXQDA
It is also possible to create a new text in MAXQDA, either by writing or transcribing (see free transcription tool f4 online) directly into the “Document Browser” or via copy and paste from a different source (internet, Word, Wordstat,
Excel, etc.).
In order to enter new text, an empty text has to be inserted into the “Document System” first. Right-click on the text
group of your choice (or the root of the “Document System”) and select the option Create text. This creates a new
text with the name “Text n” (“n” represents a continuous number in the “Document System”). In MAXQDA there
are two modes available for text editing:

Import and organization of documents
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 “Code Mode” allows you to attach codes to selected text passages, and to write memos and attach them to
text lines.

 “Edit Mode“ allows you to edit the text, add or delete text, correct mistakes, and mark text passages.
The Code Mode is active by default when a text is opened in the “Document System”. Click the Edit Mode button
to switch to Edit Mode. When working in Edit Mode you will see familiar features that are also found in most
word processors: you can choose the font type, size, and color, as well as formatting characteristics such as bold,
italics, or underline.
Open the inserted, empty text via double-click and press the Edit Mode button. You can now start entering your
text.
When you switch back to Code Mode, the modified text will be saved automatically. The same happens when
another text is opened in the “Document System”. You can tell if you are in Code or Edit Mode by looking at the
window bar: the Code Mode shows you a quick list of the last used codes.

Toolbar ”Code“ in Code Mode

Edit Mode gives you a list of the available fonts.

Toolbar “Code“ in Edit Mode

While editing your text in Edit Mode you can nullify your changes with the Undo text changes or the Undo all text
changes function; however, this is only possible as long as you remain in the Edit Mode. As soon as you leave Edit
Mode, MAXQDA will save the edited text.

Changes in the Edit Mode are only possible if this mode is acitvated

It is recommended that you do not code in Edit Mode but rather use it exclusively for the editing of texts and change
back to Code Mode when you are done.
Tip 1: If you would like to transcribe a digital interview, see chapter 15: Audio/Visual files.
Tip 2: A new text can be created with the shortcut Ctrl+T. This shortcut creates a new text at the top position of the
“Document System” and simultaneously opens it in the “Document Browser”, enabling the Edit Mode, so that you
can immediately start writing or importing. You can also move this newly-created text to any place in your “Document System”.

3.6 Inserting from the clipboard
Text passages from Powerpoint, Internet Explorer, and many other programs can be inserted into MAXQDA via the
clipboard (copy and paste) as well as with drag and drop.
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The options menu

In order to do so it is necessary to open a text (empty or existing text) into which you would like to import the passage and go into Edit Mode. Now select the text segment or the object (e.g. audio file in Windows Explorer or text
from the internet) and copy it into the clipboard by pressing Ctrl+C. It is now possible for you to import the text into
the “Document Browser” window of MAXQDA by pressing Ctrl+V.
An even easier alternative is drag and drop: simply select the segment of your choice and drag it into the MAXQDA
window.
Remember that importing audio and video files can significantly increase the size of your project file. Consider the
possibility of using external links. They can easily be integrated into existing texts. Mark the location where the link is
supposed to be inserted (e.g. a word), right-click and select the option Insert external link from the context menu.
Now you just have to select the concerned file from the Windows file dialog box.

Link a text passage to a file on your computer

To import internet pages with graphics and images, copy them to Word first and save them there or select the text
segments of your choice and copy them to the clipboard. Now, as usual, you can import the text into MAXQDA or
paste it from the clipboard. Due to the fact that a lot of web pages consist of very large and complicated tables,
many programs fail to give an adequate image of them after importing. This is also true for MAXQDA.

3.7 The options menu
You will find some important general options for MAXQDA under Options in the drop-down menu Project.

Import and organization of documents
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In the Options window you can assign attributes to the program

The settings available in the “Options” menu are basic settings that affect the way you work with MAXQDA. Each of
these settings is described in the MAXQDA manual, but the following options are worth describing here, as they are
relevant for working with documents.
Confirm deletions: This option allows you to set whether or not MAXQDA will require you to confirm any action
removing an object from your project. It makes sense to leave this box checked, since deletions cannot be undone in
MAXQDA. Your only option would be to revert to a backup of your project that was made before the deletion.
Import objects (diagrams): Checking this box causes visual objects embedded in text documents in RTF or DOC/X
format to be imported with the documents. Be aware that some imbedded graphics are very large and can very
quickly blow up the size of your MAXQDA project file!
Backup externals: Here you can set the standard folder where externally-linked files are to be kept and called up
from. If you are working in a team or are running MAXQDA from a portable flash drive that is used on various computers, this option lets you ensure that the same path is set for the folder wherever you run the program.
Do not embed if larger than [MB]: Here you can set the maximum size for PDF and image files that are to be imported into your project file. Files that are larger than this size are put in the standard folder for external files. This
option helps you avoid letting your project file get too large and unmanageable.
Tip: Audio and video files are always saved as external files rather than imported into the project file.

3.8 Importing structured documents
Overview
The preprocessor enables you to insert larger texts standardized and already pre-coded. If you have an interview, an
online survey, or the contents of a discussion forum, you may quickly supply the text material with control characters
and thereby create individual codes, codings, and documents immediately when inserting the material into MAXQDA.
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Importing structured documents

Example: An online survey contained two questions and 100 subjects filled out the survey. One RTF file was created
from all the entries which had been equipped with control characters. After the import of this single RTF file, all 100
texts are in MAXQDA (one text for every subject, e.g. with names ID1-ID100) and, for example, 2 code words “Answer to Question 1“ and “Answer to Question2“. All texts have already been coded according to these two code
words.

Importing texts in a structured way
In MAXQDA one usually creates a text group and then inserts the desired number of RTF texts. With the preprocessor it is possible to insert any given number of texts in just one RTF file and MAXQDA will automatically recognize
where to separate the texts. For the preprocessor in MAXQDA to recognize within a text where a new text begins
the text has to be completed with the respective control characters.

The following syntax has to be used:
#TEXTTextname
describes the beginning and the name of a text. Until the beginning of the next text syntax the entire content of an
RTF file will be assigned to an independent text in MAXQDA. The following text as a content of an RTF file would
produce three texts in MAXQDA which would be named Person A, Person B, and Person C.
#TEXTPersonA
My birthplace is south of New York. I moved later.
#TEXTPersonB
I am from the Black forest and I am also going to stay there for a long time.
#TEXTPersonC
I am from a small town near Chicago. Not much larger than 200 people. It’s about time I moved.
Make sure, that there are no blank spaces in between # and TEXT, as well as in between TEXT and Textname, and
capitalize the key word TEXT.Save the file in RTF format. Close Word.
Tip: You can simplify this procedure considerably if you enter, for instance, > instead of #TEXT. For the text name it
could be meaningful to insert a placeholder character first. After completing the entry you may substitute the placeholders with the key words (so, e.g., > with #TEXT) with the help of the Searching and Replacing function in
Word.
In order to import this text into MAXQDA follow these instructions:
1. Create a document group (or use an existing one)
2. Right-click on the text group and select Import structured document (Preprocessor).
3. Enter the save location of your file and confirm by pressing OK.

Importing pre-coded texts
Aside from the common import and separation into different texts, it is also possible to have the contents of a file
directly coded when importing. This makes sense when your texts have a contextual structure that can be turned into codes in a meaningful way. For this the entry syntax has to look as followed:
#CODECodename
the content is placed here
#ENDCODE
Important: No blank spaces between the # sign and the word CODE, as well as between CODE and CODENAME;
also make sure to capitalize the keywords (CODE, ENDCODE). It is also mandatory that you put a line break behind
#CODECodename and #ENDCODE.

Import and organization of documents
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Tip: The entry procedure can be simplified by using the “Search and Replace“ Word function.

The example given above could, meaningfully extended, look like this:
#TEXTPersonA
#CODEOrigin
My birthplace is south of NewYork.
#ENDCODE
I moved later.
#TEXTPersonB
#CODEOrigin
I am from the Black forest
#ENDCODE
and I am also going to stay there for a long time.
#TEXTPersonC
#CODEOrigin
I am from a small town near Chicago. Not much larger than 200 people.
#ENDCODE
It’s about time I moved.
#ENDTEXT
When importing the lines as an .rtf file MAXQDA creates three texts (Person A, Person B, Person C), a code (Origin) and has already assigned the given passages to this code.

Practice example
About 30 participants worked together in an online seminar for 3 months and exchanged information through a
discussion board. In order to better analyze the discourse which took place in the forum, the text is supposed to be
imported into MAXQDA. If one were to proceed via copy and paste from the website and then manually code the
material, it would take days, if not weeks. In this case you may also enter data from the database by adding a preprocessor control character, copying the result to Word, and then inserting it into MAXQDA. In this way it was possible, in just a couple of minutes, to import over 500 DIN A4 pages of forum entries into MAXQDA, separated by
threads and pre-coded for authors; all ready for the analysis (incl. selective programming from database).

Importing from tables
The easiest way to import structured texts is with Excel. Let’s say we did a survey of six people. We want to import
the answers into MAXQDA, so that document groups, document names, and codes are all created at one time.
We would first create an Excel table like the one below:

Example spreadsheet

For the this example, the first line must always contain the keywords "textgroup", "textname", and the code
names. The first two columns contain the name of the text group and the name of the text as they should appear in
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Importing structured documents

MAXQDA. The headings of the following columns contain the name of the codes that have to be applied to the text
segments of the particular column. Each row contains the appropriate corresponding text.
Tip: The green color in the column headers is just there to make the visualization as clear as possible; this does not,
however, have any affect on the import into MAXQDA.
To import this table into MAXQDA, we would right-click on the “Documents” icon in the Document Browser and
select “Import documents from spreadsheet,” or we could find the same option in the “Documents” drop-down
menu.
You will then see a window wherein you can select the XLS/X document that you just creqated in MAXQDA. You
will then be asked whether empy cells should be ignored or not. Choose “Yes.”
Finally, the text segments will be imported and coded according to their position in the table:

The four main windows after importing documents from a spreadsheet

All of the documents listed in the “textname” column in the Excel spreadsheet are now listed in the Document System, sorted according to the document groups you assigned in the “textgroup” column.
The rest of your column headers have been inserted as new codes and can be seen in the Code System.

Coding
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4 Coding
4.1 Codes and coded segments
One of the main functions of MAXQDA is the assignment of a “code“ to text. A code is a string of up to 64 characters, which is assigned to selected segments of text. Codes can be ordered into a hierarchical structure in the “Code
System” window. When just starting a project this window is empty except for the Code System and Sets icons. On
top of the code system, you'll see a tool bar that gives you quick access to functions often used.

A code is, in the language of empirical sociological research, a contextual category, which serves as an analytical tool
for the systematic analysis of data. MAXQDA allows the definition of a hierarchical code system with up to ten levels. The number of codes is not restricted. A color can be assigned to each code and subcode.
The development of codes is user-controlled and is not automatically conducted by MAXQDA. The process of assigning text passages (or object) to one or several codes is called coding. Text passages assigned to a single code are
called coded segments. You can always have MAXQDA show and list specific coded segments via text retrieval.

4.2 Creating codes
The “Code System” is shown as a tree structure on the screen. It looks like the file folder in Windows Explorer you
are familiar with. A plus or minus sign in front of the code name indicated that a code contains subcodes. You can
expand the subcategories or close them by clicking this button.
Defining a code is like opening a drawer in which you can put any number of text segments. The drawer’s label, i.e.
the code name, can later be changed without affecting the contents of the drawer. You can also print the “Code
System” or export it.
To create a new code in the “Code System” on the highest level you can

 either click on the

icon in the tool bar,

 use the shortcut ALT+N,
 or right-click on the

and choose New code.

The following dialog box allows you to enter the name of the new code, assign it a color, and write a code memo.
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Creating codes

The window “New code”

Newly defined codes are always put at the beginning of the list (at the appropriate level, of course).

The “Code System” after inserting new codes

Defining subcodes
To define a subcode, simply click on the next higher code. You can then use any of the options mentioned above:
either click on the symbol in the tool bar, press ALT+N, or select the option from the context menu.
In this way, we now want to setup the following three subcodes for the code “placement program:”

 preferred placement
 worst case scenario
 actual placement
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Inserting a new code

The order of the codes and subcodes in the “Code System” can easily be changed with the drag-and-drop mouse
function.
You can also sort them alphabetically by clicking the menu option Sort codes.

Attaching colors to codes
A code can be assigned any given color attribute. The best practice would be to do this while defining the code, but
it is also possible by later right-clicking on the code and selecting the option Color. The use of colors in MAXQDA
has a analytical function; it is possible to demonstrate systematic differences between codes by means of visualization. The underlying system is freely defined by the researcher; the choice can be influenced by contextual (Topic
A = blue, Topic B = yellow, etc.), methodical (phenomenological codes = red; theoretical codes = magenta), or other
aspects. While analyzing focus groups it is possible, for example, to assign different colors to different speakers.
When defining a subcode you have the possibility of it inheriting the color of the mother code by checking the
box.

Code memos
Memos can be attached to codes. This can be done while defining the code, but also later by right-clicking the code
of your choice and selecting the option Code Memo. Code memos serve an important function, especially for
teamwork: you can enter definitions or anchor examples, which are always directly accessible. (See Chapter 8.2
Code memos).

4.3 Coding text
The assignment of codes to text segments in MAXQDA is called “coding.” The smallest segment of text which can
be assigned a code is one character.
Of course, one would normally select at least one word to assign a code to. Coding is possible in different ways, but
you must always first select the passage of text with the mouse. MAXQDA offers different ways to do the coding:

 Classical coding: select a text passage and attach an existing code from the “Code System”.
 Free coding: this is the typical style of initial coding in grounded theory – a new code will be attached to each
text passage.

 Targeted, selective coding: text will be scanned for a selected code. When a text passage is found that belongs to the selected code, coding will be performed.

Coding text
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 In-vivo coding: the term in-vivo also comes from grounded theory and means that words or terms used by the
interviewees are so remarkable that they should be taken as codes. In-vivo coding adds these terms of the respondents as codes and codes the text passage at the same time.

 Color coding: This works like highlighting a text passage in a book with a colored text marker. In MAXQDA
four different colors can be used for color coding: RED, GREEN, BLUE, YELLOW or MAGENTA. The Highlight
coding toolbar can be chosen from the Toolbars menu.

1. Classical coding
In order to assign a segment to a code you will have to mark the passage first:

Marked text in the “Document Browser“

It is now possible for you to assign the passage to the given code via drag and drop (by keeping the left mouse button pressed and dragging the marked passage directly onto its assigned code). This step is also reversible, meaning
that you can also drag a code to a marked text segment.
A text segment can be assigned multiple codes.

Coding via drag and drop

In the “Document Browser”, coded elements will be highlighted with a colored visualization at the margin of the
text. By right-clicking on the square of the visualization and selecting the command Delete, you can delete the coding again.
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Code strip beside the text

The shortcut CTRL+W allows you to define and create a new code. This procedure is recommended if you, for instance, are working on a text and find a passage that you would like to code but you haven’t created a fitting code
yet. Simply mark the passage, create a new code using the shortcut CTRL+W and click OK: the segment will automatically be assigned to this new code.

2. Free coding
If you are working with grounded theory and you wish to assign a code, which does not yet exist in the “Code System”, to a text passage, it is suggested that you use the shortcut CTRL+W. A dialog box will open where you can
type in the name of this new code. The code will then be inserted into the “Code System”. You can later on, if you
choose to, move the code within the “Code System”.
Instead of using the shortcut CTRL+W, it is also possible to open the context menu by use the right-mouse button.

3. Targeted, selective coding
This procedure is especially useful if you, usually in an advanced state of your analysis, want to target certain phenomenon’s that have already been defined as codes while working on your texts. The “Quick list” above the “Document Browser” can be used for this purpose:

The “Quick list” is included in the toolbar “Code”

Left-clicking on a code in the “Code System” results in its insertion into the “Quick list”. A marked text segment can
be coded directly by pressing the Code symbol right next to the “Quick list” with the advertised code.
This procedure can also be conducted by using the shortcut CTRL+Q. After marking the text segment it is also possible to open the context menu via right-click and select the appropriate option.

4. Coding with the code favorites
If you are working with a more complex Code System, it can make sense to take advantage of the Quick List and the
“Code favorites.” The code favorites option lets you select exactly which codes are to be made available in a window, which you can then apply with a single click. You can move this window wherever it is most convenient for
you (e.g. right next to the Document Browser). The code favorites can be uses as follows:
The new “Code Bar“ is a new feature for quick coding. To add a code to the “Code Bar”, right-click on the code in
the “Code System” and Add code to code favorites:
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Code favorites facilitate the coding procedure

As soon as you add the first code, the code favorites window will appear. You can then place it wherever you want
it on your screen:
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The “Code Bar“ window can be arbitrarily adjusted

You can then highlight a text segment in the “Document Browser” and code it with one of the codes in the “Code
Bar” by simply left-clicking on the code name. This is also extremely practical if you want to code a text segment
with several of the codes.
To remove codes from the code favorites window, simply check the box next to each one that you want deleted and
then click on the

button.

5. In-vivo coding
The term in-vivo coding originated from grounded theory. It means that expressions and sayings from the text will
be used as codes while, at the same time, the concerned text segment is coded.
In MAXQDA this happens in the following way: you mark the expression and click on the In-vivo button
or use
the shortcut Ctrl+I. The expression will be added to the “Code System” and the text segment will be coded. Should
you choose to extend the coded segment, simply mark the text passage of your choice surrounding the in-vivo code
and press the Code button ; you could also use the shortcut Ctrl+Q. MAXQDA will now change the coded text
segment according to the new segment margins.
In-vivo coding can also be done by right-clicking and then selecting Code in-vivo from the context menu.

6. Color coding
Similar to traditional analysis done without a computer, it is possible to highlight segments of text with colors (RED,
GREEN, BLUE, YELLOW or MAGENTA) and code them accordingly. This procedure is recommended for an initial, raw
overview of the data material: you can mark important or noteworthy passages without yet deciding why they're
important and what they should be coded as. The color-coding function is accessible by activating the Highlight
coding bar in the Toolbars menu.
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Picture coding

Toolbar “Highlight coding”

You can then mark the text and click on the color of your choice in the toolbar. This text segment will now automatically be highlighted that color and assigned the code RED (this code will be created automatically during the first
assignment and inserted at top of the code system).
Later you can transfer the roughly-coded segments (coded RED, for example) to selected codes by using the activation function (see Chapter 5.2 Activating Codes) and choosing to only display text segments coded with RED. You
can then drag and drop the retrieved segments onto the new codes. Of course you may also keep the collection
RED and simply change its name.

4.4 Picture coding
After importing an image, you can double-click on the file in the “Document System” window in order to view it in
the “Document Browser”. To code a part of the picture, simply use your cursor to create a box (click and drag), and
then drag the code from the “Code System” window to the box. You can also choose to right-click on the box and
select one of the coding options from the menu as shown below.

Codes can be assigned to a marked region in a picture via right-clicking

4.5 Organizing the code system
Deleting codes and coded segments
It is possible to make changes in your existing “Code System” at any time. To remove a code, simply right-click on it
and choose Delete codes(s). Be aware, though, that this also deletes all subcodes!
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It is also possible to delete single coded segments by right-clicking on the little square symbol in the middle of the
coding strip of a coded segment and clicking Delete in the context menu that appears.

Deleting code after right-clicking on the code strip

Changing the structure of the “Code System”
You can change the structure of your code system by moving the codes. Simply drag a code with the left mouse
button to the place of your choice.

Copying parts of the “Code System”
It is not uncommon for codes to have the same subcodes. Given, for instance, that you have two codes “Opinions”
and “Behavior” and you would like to define the subcodes “Work”, “Politics”, and “Family” in each of them.
MAXQDA will save you the hassle of entering the subcodes twice. First, define the three subcodes for the code
“Opinions”, then right-click on "Opinions", and select Copy subcodes from the context menu; then right-click on
the code “Behavior” and select the option Paste subcodes from the context menu. This option proves to be especially useful when working with different independent team members and wanting to have the complete category
system available for all of them.

4.6 Coding with Weight Scores
In some cases, it is helpful to be able to assign relevance scores to coded segments. One could use these scores, for
example, to indicate that the segment is an especially good example for that particular code or theme.
The weight score for coded segments in MAXQDA can be set from 0-100, and unless otherwise indicated, each
coded segment receives the standard weight, which is set to 0. You can change the default weight score in two
ways:
1. Change the default weight score in the “Options” menu: The options menu can be found in the “Project” dropdown menu. Here you can enter a number from 0 to 100 to be automatically assigned to all new coded segments.
2. Change the default weight score in the status bar: The status bar is located at the bottom of the screen and
shows the current default weight score. Double-clicking on the symbol allows you to enter a new default weight.

Changing the standard weight via the status bar

Tip: It makes sense to have the default weight score as 50, because you can later increase or decrease the score. If it
is set to 0, the score can only be increased.
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Visualization of Code Segments

If you want to change the weight score for a single coded segment, you can right-click on the coding stripe in the
Document Browser and choose to “Modify weight:”

Changing the weight by right-clicking on the coding visualization

You can enter the new weight score in the window that appears:

Choosing the standard weight

4.7 Visualization of Code Segments
The visualization of a newly-coded segment is recognizable in the coding section in front of the text. The visualization of the coded segments has the same color as was assigned to the code (default= green). Via context menu in
the “Code System” window it is also possible to assign a color attribute to a code at a later time.

Tooltips pop up after moving the cursor on the code

By moving the mouse cursor over a coding strip a box will appear, giving you information about the code, its weight,
creation date, and author. Clicking on the visualization will highlight the code in the “Code System” window.
Should you choose to view only specific codes, MAXQDA offers you an array of options. By right-clicking on the grey
area of the coding section a context menu will open.
You can now select to view the visualization:
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 of activated codes,
 of codes by a certain user or
 of codes with a certain color attribute.
All of these options are available in combination with each other and it is also possible to blend out all visualizations.
Furthermore you can blend-in or blend-out the title, as well as the author and date in the box.

The type of representaion can be defined in the visualization sector of the context menu

The selection window for the visualization will also appear if you click on the
“Document Browser”.

icon in the tool bar above the

4.8 Undoing Coding Actions
If you realize that you have coded sections of documents that incorrectly or simply decide you don’t want it coded
any more, you can choose to do undo that coding.
The easiest way to do this is with the button next to the Quick List:

Button “Undo code”

Clicking on this button opens up a list of all of the coding you have done during the current session. To undo one of
them, simply click on it:
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Undoing codes

Undoing Coding Actions
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5 Retrieving coded segments
The process of finding previously-coded segments and collecting them into a list of results is usually referred to as
“retrieval.” The principal behind MAXQDA’s retrieval is simple: for each activated text, the text segments of the activated codes will be collected in the “Retrieved Segments” window.
The selection of codes and texts happens through the function of activation. Activation is a central function in
MAXQDA, which allows highly selective access to your data and enables you to conduct a quick and efficient analysis even when working on very large projects and with complex searches.

5.1 Activating documents
As you already know, all your texts and text groups are displayed in the “Document System”. To activate a particular
text you may choose between two alternatives:

 Right-click on the text and select Activate from the context menu, or
 hold the Ctrl-key and left-click on the text name(s).

In this example the documets “Joanna“,“Kim“,“George“ and “Vincent“ are activated

You can activate all texts within a text group by holding down the Ctrl-key while clicking on the name of that text
group. The names of activated texts are displayed in red, the inactivated ones in a bluish-green. Additionally, a red
arrow points out activated texts.
5.2 Activating Codes
The activation of codes follows the same principle as the activation of text documents. Either you select a code using
the right-mouse button and select the Activate option, or, as in working with documents, you left-click on the
codes while holding the Ctrl-key.
Similar to the activation of texts in the “Document System”, the color of the codes shows when they are activated:
activated codes appear red and will be pointed out by an arrow.
At the bottom of the MAXQDA window there is a status bar which lists, from the left, the total number of texts and
codes that are currently active, and the number of coded segments that have been retrieved:

The Retrieved Segments window
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The status bar provides information abaout the state of activations and the corresponding results
5.3

The Retrieved Segments window

All of the coded segments retrieved through the selection or activation of certain texts and codes are shown in the
“Retrieved Segments” window.

The “Retrieved Segments” window

To the left of each text segment you can see the name of the text and the paragraph number from which the segment originates and which code was assigned to it. If a memo was assigned to the segment this will also be displayed.

Tooltip

When you click anywhere on this box, the original text from which this segment was taken will be opened in the
“Document Browser” window at the position of the coded segment. In the example above, the following information is given: the segment was taken from paragraph 12 of the text “Joanna” from the text group “New York”. It
was assigned the code “Day-to-Day Issues > Education”.
You can also search for text segments that have been assigned more than one code. For example, you could search
for the places where the respondents spoke about their “Personal Motivation” and their “Qualifications” in a group
of interviews. More about this later.
A toolbar is located on top of the “Retrieved Segments” window where you have access to frequently-used functions. Here you can also switch to the overview of retrieved segments by clicking the

icon.
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Table view of the “Retrieved Segments”

In the top part of the table the complete text to the selected segment below will appear. This view is optimal for
reading through the results of a text retrieval and inserting comments into the table. It is possible to directly export
text segments into Word, Excel, or into a web browser, and continue working with them there.

5.4 Retrieval using the weight filter
MAXQDA also lets you use the weight scores as criteria for retrievals. The only requirement is that you need to have
assigned weight scores (see 4.6 Coding with Weight Scores). To add this filter, select “Edit weight filter” from the
“Analysis” drop-down menu. The following window will appear:

Editing the weight filter

You can then choose “Use weight filter” from the same drop-down menu to start applying the filter parameters you
just set.
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Export of the coded segments

5.5 Export of the coded segments
Exporting the complete texts of the found segments to word is possible via the menu command Codes > Export retrieved segments. You will achieve the same result with the menu command Project > Export > Retrieved segments. An RTF file will be created, which you can now open with Word.
You can choose to export the coded segments as an XLS/X (Excel), RTF, or HTML file. If you only want to export the
segments as they appear in the Retrieved Segments window, you can highlight them all with Ctrl+A, copy them with
Ctrl+C, and the paste them into another document with Ctrl+V.
If you want to export the table overview, the fastest way is to press the

icon in the table overview toolbar.

The presentation of coded segments as an HTML table is very clear and concise. This export function can be found in
the Retrieved Segments window toolbar:

MAXQDA creates an HTML file, which will automatically open your standard browser after the export. However, you
may also choose to open the file directly in Excel.
Tip: You can deactivate all codes and texts with the Reset activations icon
. You should make use of this function on a regular basis in order to prevent false results, which might come from the fact that you unintentionally activated (e.g. from an earlier search) parts of your data.
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6 Complex text retrieval
The use of the Text retrieval function enables you to search for patterns in your data and view them in
the “Retrieved Segments” window. The standard option is the Or-Combination, which looks for text segments in
any activated text with any of the activated codes.
The text retrieval dialog box allows you to choose from nine different combination options. You can switch back to
the default analysis in which the selection of codes happens through activation and all codes are included into the
text retrieval by selecting Or-Combination.
Here is an example of how you can use one of the functions:
If you want to see all coded segments that are near to another specific coding within a specific distance, you'll want
to use the “Near” function.
First activate all the texts that should be included in the search. The text retrieval window can be accessed

 in the drop-down menu Analysis > Text retrieval
 by clicking on the

icon in the menu bar or

 by right-clicking in the grey area of the Retrieved Segments window and selecting Text retrieval.

Different possibilities to activate the „Text retrieval“ function

The following window is then opened:

Export of the coded segments
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The „Text retrieval“ window

The “Text Retrieval” window allows you first to select the function for the definition of parameters. By choosing one
of the functions in the Function menu, you can see a visual explanation on the right side of the window, along with
a written explanation at the very bottom of the window. This will clarify which calculations the function conducts.
Windows A, B, and sometimes C are important for specifying which codes are to be used for the search. For the
function “Near”, one has to, for instance, specify which code has to appear in proximity of which other code and
how large the maximal distance between the coded segments should be (in paragraphs).

 The selection window is set up as follows:
 In the top section of the window a selection list allows you to select the desired function.
 The function will be visualized on the right side.
 The selection windows A, B, and C allow you, according to the selected function, to select the codes and the
definition of parameters.
Window A refers to the activated codes, which means that if one were to place a code into this window to, for instance, determine intersections with another code, both codes have to be activated first. The two codes will then be
moved into window A after clicking on the button All activated codes.
The functions Intersection and Overlapping do not require any other parameters. You simply need to enter the
appropriate codes in Window A and click Execute to start the text retrieval.
The windows B and C are active for more complex functions, where specific selections are being made. Window B
works with the code “Quick list”. For example, if we are testing whether there are text segments within the activated texts where the code listed in window A is completely inside the text segment, which has been coded with the
code listed in window B.

Tip: If nothing is being shown in the Retrieved Segments window, it could be because you accidentally chose a retrieval setting other than the standard OR combination. You can check this by looking at the status bar.
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Please consider this for complex text retrieval also: all functions of complex text retrieval only apply to activated texts
The following table summarizes the different functions:
Function

Description

Intersection

Finds text coded with all of the codes in section A. The only text retrieved is that
which is coded with all of these codes.

Intersection
(Set)

Only lists those text passages where a minimum of x codes of the codes listed in section A are present. The only text retrieved is that which is coded with these x codes.

Overlapping

Lists instances where codes in Window A overlap. Coded segments that overlap with
each other are shown in their entirety, rather than just that section that overlaps.

Only one
code

Only text segments containing exactly one of the codes in section A are retrieved.

Only this code

Similar to „Only one Code“, but only fort the code selected in section B. Only lists
text segments where the code in section B but none of the codes in section A is
present.

If inside

Text segments, that are coded with the code in section A and which are completely
contained within a segment coded with the code in section B, are retrieved. Alternatively, larger section B segments are retrieved. Multiple codes can be selected in section A.

If outside

If text segments coded with codes listed in section A are completely outside of segments coded with the code of section B, the segments are retrieved.

Followed by

If text segments coded with code(s) in section A are followed by text segments coded
with the code in window B within a distance of x paragraphs, the segment will be
retrieved.

Near

If the code in section A and the code in section B are within a distance of x paragraphs, then the segment will be retrieved.

The search menu
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7 The search function and automatic coding
In MAXQDA you can search for specific words, parts of words, or strings of words with the help of the Lexical
search function. The search procedures refer to

 the texts,
 the memos, or
 the coded segments, that are presently in the “Retrieved Segments” window.
The search can also be limited to the activated texts/documents. You may search in individual texts, in groups of
texts, or also in texts whose variables are in accordance with conditions you define.

7.1 The search menu
The search function is started by clicking on the Analysis drop-down menu and selecting Lexical search or by clicking the

icon in the MAXQDA Toolbar.

The search function in the “MAXQDA standard” toolbar

Afterwards you can export, explore, or even automatically assign your search results to a specific code word.
After selecting Lexical search, the following dialog box will appear:

The “Lexical search” window

You can enter as many search words as you like into the empty window on the left side. To do so click on New and
enter a search word or the search string you are searching for. The following wildcard characters are supported:

 ? for a single character (e.g. H?nks for Hanks, Hunks or Hinks)
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 * for multiple characters (e.g. H*ks for Hanks or Hawks)
 < for beginning of word (e.g. < (inter) for Interest or interesting, but not winter)
 > for end of word (e.g. (ks) > for Hanks or thanks, but not Bankside)
You can remove a search string by clicking Delete or change your search entries by double-clicking on them.
You have the option of searching In documents or In memos. If you enter multiple search words, you can decide
how to combine them for the search function. OR leads to results in which at least one of the search words is contained. The option AND finds those text segments, which include all search words. In this case it is necessary to set
the maximal distance within which the words must be to each other. (Example: List all text segments in which “fear”
and “terror” appear within 2 paragraphs of each other).
Other practical possibilities are options like Find whole words, Case sensitive, Only in active texts, or Only in retrieved segments. These options are especially useful if you want to narrow down your search.
The search will start after you click Run search.
Text search procedures can be saved by clicking on Save, entering a name for text search procedure, and clicking
Save again. Text search procedure files will be saved with the file extension SEA (the abbreviation stands for search).
Saved text search procedures may be opened again at any time.

7.2 The search result window
Depending on how much text must be searched, the search process might take some time. The search results will be
shown in a separate window. On the top right the number of hits will be listed. The tabular overview allows you to
sort your hits by clicking on the column headers. The most important function, however, is that by clicking on a hit,
the corresponding text will automatically be loaded into the “Document Browser” window in the background; the
concerned text segment is already marked, which is ideal for the exploration and analysis of your findings. This way
you can read through hit after hit and, if desired, code them manually.

The list of search results

Exporting the search result
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In the toolbar, located on top of the “Search results” window, a couple of important functions are available. The
icon and the

icon allow you to show the results as an Excel and HTML table.

7.3 Exporting the search result
The
icon allows you to export the results to an RTF, HTML or XLS/X document. The saved file will immediately be
opened in the appropriate program (e.g. Word, Firefox, Excel, etc.) depending on the format you exported it in.
The
icon allows you to automatically code the results; and the
tomatic coding or export.

icon allows you to change settings for the au-

Remember to decide before exporting, with the help of the options, if you would like to export the search string
(word), the sentence, the paragraph or a certain number of paragraphs before and after the search string.

Options for exporting hits

7.4 Automatic coding
One especially handy option is to automatically code all of the places where the search string was found.

Options for automatic coding of hits

Sometimes it might make sense to code all of the text segments that were found in the search. MAXQDA can do this automatically. Simply click on the
icon and select the desired code from the appearing list. Only codes from the “Quick
List” will be available. If the code you want is not there, simply click on it in the “Code System” first.
Before you click on the
button, you need to select what aspect exactly you want to code. You can
code the search word, the sentence in which it was found, or even the entire paragraph where your search word
appears. Usually it makes sense to code the paragraph in which the search word was found.
This procedure of automatic coding will most likely code unwanted hits as well. After completing the above mentioned code procedure you can easily remove these from the “Code System”. Simply activate the newly created
code as well as every text involved in the search. The results will be shown in the “Retrieved Segments” window,
and you can delete any unwanted codings by right-clicking on the yellow box and selecting Delete.
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7.5 The Context Searches in the Four Main Windows
Starting with MAXQDA10, you have the option of searching within each of the four main windows. You will find a
magnifying glass icon in the toolbar of each of the four windows. You can use this search field to find text segments, document names, codes, coded segments, etc.

The search function is available in all four main windows

Context search window:

After typing in your search term, you will be able to jump back and forth between hits with the arrow buttons.
Tip: The search only works for the window in which you have called up the context search window – it does not
search through the entire project.
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Memos in the Document System

8 Memos: managing your ideas
Memos are a classical, central instrument of qualitative text analysis and are especially significant in “Grounded
Theory”. The functionality of memos in MAXQDA has been extended far beyond the known possibilities of “tacking
on“ information to a text. MAXQDA gives the researcher highly effective and, at the same time, user-friendly options to create memos in various ways, to always have access to them, to administer them, and also to conduct lexical searches on all of them.
Memos can be assigned to a project, a document group, a document, text segments, or a code. Like the well-know
Post-It notes, memos are illustrated in yellow. Free Memos are a new addition in MAXQDA10. They are assigned to
the project as a whole rather than to a specific document, code, etc. They can always be viewed in the “Memo
Manager” (see below).

8.1 Memos in the Document System
The first option for creating a memo is in the “Document System”. Here you may write a memo about your project
in which you can document the process of your research, the schedules, etc.
Values like age, gender, etc. are better attached as variables, since one can later use them as limiting values in the
text retrieval. You can also assign a memo to a text group or even a single text. A text memo allows you to, for example, explain the origin of your text and write down important meta information.
Right-click the concerned document and select Document memo from the context menu:

Right-click on a document to insert a “Dokument memo“

All memo entry windows in MAXQDA look identical, no matter where you want to attach the memo. There you can
enter the author and a title (select a meaningful title; it will simplify finding it later!), select a fitting memo symbol
(e.g.: ? for a question, ! for a definition, T, L, or M for a theoretical, literature, or methodological memo, or make up
your own meanings for each symbol), and, of course, write the memo text.
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The Memo window

When you are done with your entries, simply click on
icon to close the window. After closing the memo window, the memo will appear next to the concerned text in the “Document System” and may always be opened via
double-click. You will also be presented with a content preview when holding the mouse over the memo symbol.
For all the elements in the “Document System” you are only able to write one memo. The reason being that the
presentation remains clear and organized and, when searching for a specific note, one does not have to look
through a number of memos, thereby slowing your analysis process.

An abstract of the memo will be shown if the cursor points on its symbol

8.2 Code memos
In the “Document Browser”, you can attach as many text memos directly into as many parts of an opened text as
you want (e.g. to record concrete ideas or questions, literature, etc.).
In the “Code System”, you can attach one “code memo” for each code and subcode (e.g. for code definitions or
anchor examples). To insert a memo right-click on a code and select the option Code memo. An existing memo will
be visualized with a yellow Post-It note there, as well.
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Memos direct at the document

Visualized code memo

8.3 Memos direct at the document
In the “Document Browser” window, memos will be created, shown, and opened from the memo column next to
the text, directly to the left of the paragraph column. If you want to attach a memo to any given text segment,
double click on the memo column at this position or right click on the memo column next to the text and select
New memo.

Memos are attached via right-click or double-click in the grey column left to the document

8.4 Linking codes with memos
Each memo can be assigned a code from the “Code System”. To do this click on the corresponding symbol in the
toolbar and select the desired code from the “Quick List”. If a code is not in the “Quick List” you have to insert it by
clicking on it in the “Code System”.
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Memos can be attached codes from the “Code System”

8.5 Free memos
MAXQDA 10 lets you create memos that are not connected to any specific aspect of your project, but apply rather
to the project as a whole. These are called “free memos.” You might use these memos for basic information about
the project, research hypotheses, research goals, etc.
Creating free memos is easy – just select “New free memo” from the “Memos” drop-down menu.

Free memos are valid for the whole project

These memos can be viewed or edited at any time in the Memo Manager.

8.6 Memo Manager
The Memo Manager is a table containing all memos that you have created. You can sort them according to the
properties contained in the columns (name, memo type, etc.), open them by double-clicking on a memo row, edit
them, if need be, or export the whole table.
If you attached a memo to a section of a document and then view it in the Memo Manager, the attached text will
automatically be loaded into the “Document Browser” window and the concerned text or picture segment becomes
visible.
The Memo Manager can be opened by clicking the
icon in the “MAXQDA standard” Toolbar. You can also call
it up by selecting “Memo Manager” from the “Memos” drop-down menu.
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Memo Manager

The “Memo Manager” gives an overview of all existing memos

By clicking on the individual column headers the list is sorted according to the various criteria. For example, you
could sort by memo symbol, listing all memos with a question mark, for example, to clarify all open questions swiftly. A double-click on a line opens the memo window and lets you view the complete content of the selected memo.

Copying memos
If you'd like to re-use a memo within another text or at another text position, you can also right-click on the memo
and choose Copy.
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Memos can be copied and inserted at other places

Then, use the “Document Browser” to navigate to the new position, right-click the memo column and choose Paste
memo. This will insert a copy of your memo which is editable without affecting the original memo.

Copied memos can be insertetd via right-click on the memo column

Tip: The memos can be exported by clicking the
icon. This function allows you to create either an RTF, an HTML,
or an Excel file. MAXQDA exports all selected (highlighted) memos. If no memo is selected all memos will be exported.
The memos can also be highlighted and then copied to Excel or other programs via the clipboard. This does not
transfer the entire memo content, however, but only a preview.
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Linking text segments and images

9 Links: linking your documents
9.1 Linking text segments and images
In order to point out a relation between two text segments, you have the option to link them to each other. Click on
one of the two linked text segments and you will reach the other one. Text links enable you to connect two text
segments with each other. They have the same meaning and serve the same function as hyperlinks in the internet,
namely to connect two points: an anchor and a target. As soon as one clicks on the anchor of an existing link, the
corresponding target will be loaded and vice versa.
The text links in MAXQDA can link text segments either from the same text or from different texts. In order to insert
a text link, the first text segment – the anchor – has to be marked in the “Document Browser”. The smallest unit you
can mark is a single character, but in most cases, you will want to mark at least a phrase if not a sentence or paragraph.
After highlighting the text segment, click on the
icon or right-click on the highlighted text and select Insert text
link from the context menu–the text segment will now be marked blue. Now, mark the other text segment (which
can also be in another text) and, again, click on the
icon or select the option from the context menu. After the
second text segment appears underlined, you are able to jump from one text segment to the other by clicking on
either one of the text segments.

Text links are visualized blue and underlined

In order to remove an existing text link, right click on one of the two underlined text passages and select Remove
text link. The other link partner will be deleted automatically.
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Text links can be removed via right-click

Tip: If you want to link more than two text segments, place another link directly next to the first link, which leads to
the desired third (fourth...) segment.
In addition to having the option of linking from one text segment to another, you can now link a text segment to a
coded section of an image. To do so, make sure that you are not in Edit Mode and highlight the text you wish to
link. You can then either

 right-click and choose Insert text link,
 click on the

icon in the Code toolbar, or

 use the hotkey Ctrl+L.
Now double-click on the image file in the “Document Browser” and right-click on the code in the “Document
Browser” and choose Insert text link.
You will now be able to go back and forth between the text segment and the coded image segment by clicking on
either one.

9.2 Links to external documents and websites
It is also possible to connect a text or image segment to something outside of the MAXQDA project – this is then referred to as an external link. Clicking on this link will then open the document or website that has been connected
with that text or image segment. You could, for example, link each speaker in a transcribed group discussion to a
picture of that person or to a document with additional information about that person.
To create an external link,

 highlight the text or image segments,
 right-click on it and select “Insert external link,” and
 choose the file to be linked to in the window that appears..
You can also link to a website:
1.

Open the website in your internet browser, highlight the URL, and copy it with Ctrl+C,

Geolinks
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2.

switch to MAXQDA, highlight a text or image segment,

3.

right-click on the highlighted segment and choose “Insert external link,” and

4.

click “Yes” when asked if you want to paste the link.

9.3 Geolinks
Geolinks are connections between a text or image segment and a certain geographic location, allowing you to include geospatial information in your data analysis. A click on a geolink opens a program (usually Google Earth®) and
takes you to that geographic location.
To insert a geolink, follow these steps:
1.

Save the location in Google Earth® by clicking “Save” from the “File” drop-down menu. The location will
be saved in a KML file.

2.

Highlight a text or image segment in MAXQDA, right-click on it, and choose “Insert geolink.”

3.

Select the KML file from the window that appears.

The existence of a geolink is shown with a green ball in the geolink column next to the text or image in MAXQDA.
You can toggle this column on and off by right-clicking on the document in the Document Browser and choosing
“Show geolink bar.”

9.4 Overview of links
Similar to the tabular overviews of coded segments and memos, MAXQDA offers an overview of all links in your
project. Open the drop-down menu Documents and then select Overview of links. The overview lists all links with
anchor and target. Clicking on a specific link will result in a jump to this text segment, which will appear in the
“Document Browser”. The links overview can be exported in XLS/X, HTML, or RTF format by clicking on the appropriate icon in the toolbar.

The “Overview of links” associated to a project
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10 Case variables and activation by variable
MAXQDA differentiates between document and code variables. More information about these two variable types
can be found in the manual.

10.1The list of variables
MAXQDA enables the administration of variables for every text, as is common in statistics programs. You can, for
example, record relevant personal data and contextual information for a text or classify specific types of text and
then code the texts according to their variable values. (For example, you could add a gender and an age atrribute for
interview transcripts, so you could compare male interviewees of a certain age group to female interviewees of a
specific age group.)
MAXQDA offers two different views: the standard variable view is called the List of variables, found in
the Variables drop-down menu. The data view can be called up by clicking on the
icon in the “MAXQDA standard” toolbar or by selecting Edit in the Variables drop-down menu. You can switch between the two views by
clicking on the

icon.

You will notice in the “List of variables” that there are already several internal variables that MAXQDA has already
created for you, such as the “text size”, “group”, “author”, “creation date”, etc. You will see a total of seven of
these standard variables, which will always be differentiated from the variables you create by the red square in the
far left column. User-defined variables will have blue squares.
The toolbar at the top of the window includes buttons for creating new variables and switching between the two
variable views.
In the “To be displayed” column, you can define which variables are displayed in the data view. When working with
a lot of variables the tabular view might become somewhat confusing, so the option of displaying only selected variables can come in handy.

Varibles can be diplayed or hidden via the column “To be displayed”
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10.2Creating variables
To create a new variable, click on the
icon in the “List of variables.” Next, enter a name for the variable, such as
“Gender“, “Education“, “Marital Status“, etc. and select the variable type. Five types of variables are available:

 String - for entering text (e.g. male, female, student)
 Integer - for entering a whole number (e.g. 1, 7, 3940)
 Floating point - for entering a number with decimal (e.g. 2.3, 453.5, 0.09)
 Date/Time - for entering time or date
 Boolean - creates a box, which can either be checked or left unchecked.
If you want to define the gender of each interviewee, for example, with the letters “m” and “w,” you would want
to choose the variable type “string.” Keep in mind that it is not always possible to change the variable type at a later
time. Numerical variables can be changed to string variables, but not vice versa.
This way you may define an (almost) infinite number of variables. The rectangular data matrix (documents * variables) can later be exported directly to statistical programs such as SPSS, SYSTAT, STATA or Excel.

10.3Entering data
In order to enter data, you have to switch from the “List of variables” to the data view by clicking the
icon in the
toolbar. In the data view, you will see all variables, which were marked as To be displayed in the “List of Variables”
view. If hadn’t previously been viewing the “List of Variables,” you can directly access the data view by selecting
“Edit” from the “Variables” drop-down menu or by clicking on the

icon in the toolbar.

The table in data view is similar to a data matrix found in SPSS or Excel.

It can be switched between the “List of variables” and the “data view” via a special button

Each row of the matrix corresponds to a case (document) in the “Document System”. The variables are listed in the
columns. This way you can enter one value for each case (text) and each variable. All variables can easily be imported/exported to/from SPSS and Excel.
If your variable appears in the overview (you might have to scroll the list further to the right), you can assign your
document a variable value by double-clicking in the corresponding cell. The entering of values into a newly created
variable is easiest, when you begin with the top row: double-click into the first cell, enter the corresponding value
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and confirm with the Enter key. The cursor will now automatically jump into the next row and you may begin the
entering of the next value.

Inserting data into cells of the data matrix

If you want to select a value that has already been entered previously in the same column, you can click on the arrow to the right of the cell and select the appropriate value from the list. This is especially useful if the variable values
to be entered are rather long, as with job descriptions, for example. The list of values can be extended at any time;
new values will be adopted into the list immediately.
By clicking on the column headers you can sort the existing variables. According to the type of variable selected,
the sorting will be done alphabetically, numerically, or chronologically. Repeated clicking changes the direction of
sorting. Similar to the “Document System”, a text can be opened in the “Document Browser” window by doubleclicking on a row in the variable window.
By right-clicking on a column header, you can access several additional functions:

The context menu can be opened by right-click

The Search function allows you to search for a certain value within the list of variables, such as a certain date in
the “Creation date” column.
Hint: When searching within table fields, you will only find cells beginning with your search string. In order to find
any matches, start your search string with a * as wildcard character.

Importing and exporting variables
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The Set filter function allows you to filter out the texts that do not match a certain variable. By setting the filter for
“Number of Memos” to “1”, for example, you would be shown only those documents that have exactly one memo
assigned to them.
Selecting the Hide option hides that particular column. In order to view this column again, simply switch back to
“List of Variables” view by clicking the

icon and re-check the appropriate box in the “To be displayed” column.

If the option List of values is activated MAXQDA presents all existing values in a column as a list while typing in a
new value for a document.
The Select fields function calls up a window, where you have the option to choose which columns should be displayed. The internal variables are red, and the variables that you have created are black.

Selecting fields

10.4Importing and exporting variables
As in the data view, the variable view makes it possible for you to export your data in XLS/X, HTML, or RTF format in
the toolbar.
It is especially helpful to be able to export the data matrix, because it can be directly imported into statistics programs like SPSS or SYSTAT for quantitative analysis. This export function is also available in the “Variables” dropdown menu by selecting Export data matrix.
If you want to work with this data in SPSS, it is recommended that you choose to export in XLS/X format, since it can
be imported without any formatting changes.
Attention: If you are working with an SPSS version older than version 13, any variable names longer than 8 characters or that include spaces will be adjusted automatically by SPSS.
To import the data matrix, follow these steps:

 Export the data matrix as an Excel file.
 If necessary, add new columns with the variable names as the column headers.
 Import the data matrix by clicking on Import in the Variables drop-down menu.
 Choose the appropriate format for each of the variables.
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Importing and exporting variables

11 Working with overview tables
MAXQDA offers a number of table overviews of various aspects of your project, and these tables can be worked
with a lot like an Excel file.
Let’s look at the following example, which is the case variable overview:

The “List of variables“ in MAXQDA

Each table has a toolbar at the top, which gives you quick access to the most frequently-used functions. This particular table above, for example, has a toolbar with symbols for opening the table in XLS or HTML format, for saving the
file in XLS format for use in SPSS, and for switching between table views. The
symbol is found in every table –
clicking on it closes the window.
The column headers in the table above represent each variable, and the various font colors indidcate what kind of
variable each one is.
The system fields or project variables are always in the table and include:

 Document group – shows the name of the group in which the document is found.
 Document name – shows the document name.
 Number of coded segments – shows the number of coded segments found in that document.
 Number of memos – shows the numerb of memos found in that document.
You can always change the width of each column individually by clicking on the column seperator and dragging to
the right or left. Double-clicking on the seperator adjusts the column to its optimal size.
You can change the order of the columns by clicking on a column header and dragging it to a different location.
If you right-click on a column header, you’ll call up a context menu. Here you have the option to hide certain columns that aren’t currently of interest to you. You can call up a list of each of the columns and only check the box
next to those that you want to view.
You can very easily sort the tables according to the values of any of the columns by left-clicking on that column
header.
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Arranging a chart by clicking on the column header

Tables can be sorted in alphabetical or reverse-alphabetical order. The first time you click on the column, it is sorted
alphabetically; the second time you click on it, it is sorted reverse-alphabetically. You can tell which order the sorting
has been done in based on the direction of the arrow next to the column name.
MAXQDA tables have both editable and non-editable columns. The internal system columns, for example, can never
be edited. If you want to change a document name, for example, you have to do that in the Document System, not
in the variable list. The same is true if you want to change the document group for a particular document. You must
drag the document from one group to another in the Document Browser. In the editable fields, you can simply
double-click on a cell and type in a value.
You can also copy sections of the table to the Windows Clipboard to paste them in other programs by highlighting
the selected cells and hitting Ctrl+C. You can also select the entire table with the Ctrl+A keys.
If you paste the contents of a table into Microsoft Word, they will be inserted with the cells separated by a tab.
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Code Matrix Browser

12 Visual tools
In addition to MAXMaps, the mapping tool of MAXQDA, there are seven other visual tools, six of which you can see
in the toolbar “Visual tools”. If the toolbar is not visible, simply activate it in the Toolbars drop-down menu. These
tools are also all available from the Visual tools drop-down menu.

12.1Code Matrix Browser
The “Code Matrix Browser” offers a visualization of the number of segments coded with each code for each document. Select the tool as described above. If you have documents or codes activated, you will be given the option of
including only those activated documents and codes in the visualization. If you have too many codes or documents,
the option to narrow things down is very helpful. Otherwise, select No to see all documents and codes in the visualization.
You can access the Code Matrix Browser in the Visual Tools drop-down menu or by clicking on the
the Visual Tools toolbar.

symbol in

Starting the “Code Matrix Browser” via the drop down menu

Tip: If you only want to include activated documents and/or codes in the visualization, you will have that option
when you first call up the visualization.
After making your selection, you will see the following screen:

Code Matrix Browser: documents on the x-axis and codes on the y-axis
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The Code System is displayed on the y-axis, and the documents from the “Document System” are on the x-axis. The
number of coded segments for each code in a document are represented by the squares. The color and size indicates the number of coded segments.
By moving your mouse over the square, you can see the details:

Tooltipp inside the “Code Matrix Browser”

In the example below, you can see that the code "Day-to-Day Issues" was used to code 8 different segments in the
document "Kim".
The toolbar at the top of the “Code Matrix Browser” window offers you more options for your visualization:

shows the Code Matrix Browser in Excel.
allows you to export the browser as a TXT (tab delimited) or a XLS/X file.
takes a snapshot of the “Code Matrix Browser” window.
shows the coded segments represented in the Code Matrix Browser in a table.
these three different buttons set the width of the document names on the x-axis. The first option is used
in our above example. The middle option displays an abbreviated version of the document name, and the third option on the right displays the entire document name (see below).
changes the squares to numbers, so you can see exactly how many coded segments were made in each of the
documents:

Display of the number of coded segments in the “Code Matrix Browser”

uses circles instead of squares for the visualization.
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simplifies the visualization by using only one size of square or circle. You can tell whether a code was used in
each text, but you can't tell how often it was used.
refreshes the visualization for those situations where you add coded segments while the “Code Matrix Browser” window was open
displays basic information about the “Code Matrix Browser“.
closes the window.
this is the scroll bar. If you have many documents or are displaying the entire name of each
document, it might not be possible to view the entire visualization in the window. The scroll bar allows you to scroll
along the x-axis.

12.2Code Relations Browser
The “Code Relations Browser” creates a visualization of the intersections of codes in either a single document, a
group of activated documents, or all of the documents in the “Document System”. This allows you to find connections or relationships between your codes.
Open the “Code Relation Browser” as described at the beginning of this chapter. If you have codes and documents
activated, you will be asked if you wish to analyze only these codes and documents.
If you want to analyze all codes and documents, click No. You will then have the option to select which codes
should be displayed on the x-axis. After clicking OK, the visualization will appear:

Before starting the “Code Relations Browser” you have to choose the codes on the x-axis

After making your selection, you will see the following screen:
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Code Relations Browser: number of intersections between codes

As in the “Code Matrix Browser”, the size and color of the squares indicate the number of instances the codes on
the x-axis overlap with the codes on the y-axis.
The toolbar is almost the same as for the “Code Matrix Browser” (see above) except that there are two new buttons:
The
icon changes the visualization to display situations where the coded segments are near each other instead
of intersecting.
Click on the

icon to set how close the coded segments must be to each other to be counted.

Setting the options for the “Near” function

If the maximum distance is set to two paragraphs, for example, coded segments that are within two paragraphs of
each other will be counted for the visualization.

12.3Document Portrait
The “Document Portrait” is a visual representation of all the coded segments in a selected document.
In order for this visualization to have meaning, it is necessary that you associate colors with codes in a manner meaningful for you, so that you can differentiate between codes based on their colors. If you were doing a psychological
analysis, for example, you might have associated the code for aggression with the color red.
To open the Document Portrait,

 Right-click on a document in the Document Browser and choose Document Portrait from the context menu
that appears, or

 click on the document in the Document Browser and then select Document Portrait from the Visual Tools
drop-down menu or click on the

symbol in the Visual Tools toolbar.
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If you have activated codes, you will be asked if you want to only visualize those codes in the “Document Portrait”.
Click No if you want all codes to be included. The visualization window will then appear.

The “Document Portrait” window

The colored squares represent coded segments in the document. You can now see which codes are used in the document and get an idea of the proportions between the various codes. The white spaces represent text segments that
are uncoded. If you click on a colored section of the visualization, the corresponding text segment will be highlighted and displayed in the “Document Browser”.
The toolbar for this visualization offers some functions that are not present in the other visualization toolbars:
Export – saves the visualization as a graphics file.
Visualize whole document or coded text – allows you to switch between displaying the uncoded segments as
white and leaving them out completely. This can be especially helpful if there are large portions of uncoded text.
Mixed colors for overlapping codes (yes/no) – decides how segments should be visualized that are coded with
more than one code. If the above option is off, each of the colors of the codes used to code the same segment will
be listed sequentially, one after the other, similar to how it works in the Overview of Coded Segments. If the option
is turned on, the colors of each assigned code are mixed together.
Display nodes as circles (on/off) – lets you switch the symbols in the visualization back and forth between
squares and circles.

12.4Codeline
Similar to the Document Portrait, the Codeline is a visualization of a single document. It generates a matrix made up
of the text paragraphs and the codes used in those paragraphs. The colors in this case only serve an aesthetic purpose, so it is not necessary that you have made meaningful color associations before using this tool.
The Codeline is called up …

 by selecting Codeline from the Visual Tools drop-down menu,
 by right-clicking on a document and choosing Codeline from the context menu that appears, or

Visual tools

 by clicking on the appropriate symbol
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in the Visual Tools toolbar.

You will then see a dialogue box with the option to only include activated codes (if you have any codes activated)
and to aggregate subcodes on the first level. The second option is helpful if you have many subcodes, but want the
level-1 code to represent all its subcodes in the visualization.

Options for creating a “Codeline“

After clicking OK, the “Codeline” visualization window will appear:

Codeline: codes in chronological order

In the example above, you can see the code names on the y-axis and the paragraph numbers on the x-axis. We can
tell that the code “placement program” was used in paragraph 5, and “day-to-day issues” was used in paragraph 8.
To scroll through the paragraphs, you can use the scrollbar at the top of the window:

When you use this scroll bar, the list of codes on the y-axis remains visible, so you don’t lose sight of which rows
represent which codes.
Icon functions:
This button takes a picture of the visualization as it is currently seen in the window and saves it as a BMP file.
This button refreshes the graphic, which is helpful if you have changed coded segments since opening it. This
saves you the time of closing and reopening the visualization.

12.5Document Comparison Chart
This visualization allows you to compare the codes used in each document. You can call up the Document Comparison Chart:

 by selecting Document Comparison Chart from the Visual Tools drop-down menu, or
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 by clicking on the

icon in the Visual Tools toolbar.

If you have codes or documents activated, you will be asked if you only want to use these codes and documents. To
include all documents and codes, click No. The chart will now appear:

Document Comparison Chart: comparing codings of texts segments

The documents from your “Document System” are displayed on the y-axis, and the paragraph numbers are on the
x-axis. The colors correspond to the assigned color in the “Code System”. In the above example, orange represents
the code "Work Issues", violet represents "Day-to-Day Issues", etc. You can see then that in the document "Joanna", the paragraphs four to eight each included at least one instance of the code "Work Issues", with at least one
instance of the code "Day-to-Day Issues" in the eighth paragraph.
Double-clicking on a section of the visualization opens the associated document in the Document Browser and highlights the appropriate paragraph. The scrollbar at the top of the window is helpful for moving through the paragraphs without losing the y-axis labels. You also have the screenshot

and refresh

Tip: This visualization is especially helpful if you are comparing structured interviews.

icons in the toolbar.
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13 Mixed Methods Functions
MAXQDA offers a number of mixed methods functions, allowing for the combination of qualitative and quantitative
data. They can be found in the Mixed Methods drop-down menu:
Activation by variable – lets you activate documents or sections of documents to be included in retrieval based on
variable values. You could, for example, use this function to find out what all men between the ages of 40 and 50
said about migration issues.
Quote Matrix – creates a Word file showing what different groups said about a theme based on certain variable values that you specify. Each group’s coded segments for the specified codes are in a different column. You could, for
example, choose to see how those with various levels of education differ on their approach to combating homelessness.
Crosstabs – works parallel to the Code Matrix Browser, except that this function doesn’t work on the document level. Instead, you can create groups based on your variable values and compare how often each of these groups talks
about each theme. You could, for example, compare how often men talk about relationships in your life satisfaction
interviews in comparison to women.
Typology tables – shows an overview of variable values for qualitative typologies that you have created (e.g. for
people with various views on combating their own homelessness). You could see, for example, what the mean age,
gender breakdown, and average time already homeless is for the “apathetic pessimists” in comparison to the
“proactive optimists.”

13.1Activation by Variable
The activation of texts cannot only be done manually but also automatically. With the Activation by variable function, the values of variables play the control function for text activation. If you defined the variables ”Gender“,
“Age“, and “Education“ it is possible to start a text evaluation only for women of a specific age group, who received a college degree. The selection criterions for the text analysis have to be entered in a standardized way. The
syntax that MAXQDA demands for the entry of such logical conditions is similar to those of statistical programs, such
as SPSS.
The Activation by variable function always refers to the whole, currently opened project. You can access the function by choosing Activation by variable from the Mixed Methods drop-down menu or by right-clicking on the
Documents icon in the Document System and choosing Activation by variable from the context menu that appears.
All logical formulas must have the following components:
variable name / operator / value
If you have created a variable called “gender” and used the characters “m” for male and “f” for female, we would
use the following formula in order to activate those documents or document sections that have been assigned to
women:
gender = w
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Crosstabs

Selecting the value of a variable

Entering logical formulas for your activations can be done in the window shown below. Additional details can be
found in the manual.

The options window for the “Activation by variable” function

13.2Crosstabs
The Crosstabs function has some similarities to the Code Matrix Browser, except that groups of documents are analyzed instead of single documents. Social groups, such as men and women, or people with different personal background, etc. can be grouped based on variable values. All of the variables that are in your project can be used to set
up a group.
The first step is to activate codes in the Code System. If no codes are activated, the Crosstabs option in the Mixed
Methods drop-down menu will be grayed out.
After activating codes and clicking on Crosstabs, a window will appear where you can enter formulas for the various
columns.
First, click on the New button to create the first formula. A screen will appear with all of the variables in the project,
which you can use to create the formulas.
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Selection of variables

You can see in the screenshot above that the variable “Gender” has been selected. You would then click on OK to
go back to the formulas screen.
You can then set the formula for which gender is to be represented in that column. On the right side of the variable
selection window, you will see the option to Insert all values into the table. In the case of gender, this would
mean that both men and women would be put in a column.

Different values of a variable can be added

Simply click on OK to create the Crosstabs.
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The “Crosstabs” window

The codes are listed on the y-axis, and the specified variable values are listed on the x-axis at the top of each column.
Each cell shows how often each code was found in documents where Gender=Female (column 1) and where Gender=Male (column 2).
The following options are found in the toolbar at the top of the window:
Shows the matrix of values in Excel.
Exports the matrix of values in either XLS/X or TXT (tab delimited) format.
Saves a snapshot of the window as it is currently seen in BMP format for later use in a presentation.
Opens a Quote Matrix for the selected codes and groups in the Crosstabs window.
Changes the calculations to be based on the number of documents that contain the code rather than the total
number of segments coded with that code.
The next three icons set how the values are shown in the matrix cells:
Number of segments – meaning the code frequencies for each group are shown as a value.
Row percentage – meaning the value for each cell is shown as a percentage of the frequency of the code in all
groups (horizontal percentage).
Column percentage – meaning the value for each cell is shown as a percentage of the frequency of all codings
in that group (vertical percentage).
Refresh – recalculates the values in the table.
Showing information about the function.
Closes the Crosstabs window.
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The “Row percentage“ view

Example: 60% of all coded segments about “Emotions” were from documents representing female interviewees.

The “Column percentage” view

Example: 8.4% of all coded segments in the documents representing male interviewees were coded with the code
“Emotions.”

13.3The Quote Matrix
The Quote Matrix is based on the same idea as the Crosstabs function, i.e. to create a joint display of themes and
quantitative variables. The Quote Matrix does this on a more detailed, non-aggregated level. Here the coded segments themselves are listed in the cells of the matrix, not only the number of coded segments for that particular cell.
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Typology Table

In the example below, we can see a comparison about what married people said about certain themes compared to
what single people said about them.
In theory, it would be possible for you to create a Quote Matrix on your own by doing retrievals in MAXQDA for
each group and copying them from the Retrieved Segments window into a table in Word, but this would take a lot
of time, and the sources of each segment wouldn’t be listed.
The results of your Quote Matrix are opened automatically in whatever program is set to open RTF files (e.g. Microsoft Word). The coded segments retain the formatting that they had in MAXQDA. If some of your documents are
formatted differently than others, this could lead to a chaotic-looking document. It is recommended in these cases,
that you highlight the whole table and assign the same font and size to it.
In order to ensure that the Quote Matrix is readable, it is limited to a maximum of four columns. If you absolutely
have to have more columns than that, you can create two different ones and bring them together in your word processor. The Quote Matrix assumes that you are working with categorical variables. If you want to display metric variables, you need to use the Typology Table.

13.4Typology Table
This function offers yet another way to combine quantitative data and your codes. It is called a Typology Table, because it is able to calculate various variables and their percentages (means, standard deviations, etc.) for qualitative
typologies.
The table is set up similarly to the following example from Creswell and Plano’s book “Designing and Conducting
Mixed Methods Research” (2010: 292):

Example of a Typology Table

Here, the rows contain different variables divided into two sections: “Sociodemographic characteristics” and “Psychological status”. The table starts with age, which is obviously a metric variable. The next row lists the number and
the percentage of women, a category in the categorical variable “sex”. The third row gives a number and also the
percentage for the African Americans, also a category of a categorical variable. The next row also gives information
about a categorical variable “education less than high school”. The next three rows after the heading “Psychological
status” all deal with metric variables. Let’s go into more detail:
The first column of the table “characteristics” contains the name of the variable. The second column “Physician
rated patient depressed n=27” gives aggregated information for 27 patients: on average, they are 73 years old with
a standard deviation of 5.3 years. Twenty-one of the 27 persons are female, which is equal to 79%.
The third column “Physician rated patient not depressed n=21” gives aggregated information for another group of
patients. With an average age of 77.1, they are older than the first group. The standard deviation (5.3 years) is exactly the same as the other group. Fifteen of them are female (71%), slightly less than in the first group. The fourth
column gives a probability for a significant difference based on the comparison of group data.
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14 Teamwork
14.1Styles of teamwork
MAXQDA offers three different options for working in a team:

 All team members work on the same project file alternately.
 All team members work with the same text material and exchange their coded segments, memos, and variables.
 All team members work with different texts and want to merge their partial projects to one single project.
14.2Alternately working on the same project
The first option is very easy to do. If your team works on the same computer on different days, it is possible for every
team member to simply sign in with their own user name in MAXQDA and open the aforementioned project file (see
Chapter 1 First steps in MAXQDA). All program objects (documents, codes, memos, and coded segments) receive
the same “stamp” (username), which gives information about who created which code/coded segment/memo and
when.
You can also send your project file via E-mail to another team member. Just make sure that you do not work on that
file on your computer in the meantime, and wait until the other team member sends his worked-on file back. Simply
click Open other projects in the startup window of MAXQDA and search for the project file that has been sent to
you.

14.3Exchanging and comparing coded segments, memos, and variables
Coded segments, memos, and variables, which have been created by different team members, can be merged with
the help of the Export teamwork or Import teamwork functions. These functions can also be used to compare
coded segments. It is necessary, however, that the body of data remains identical; the team members exchange
memos, coded segments, and variables, but the texts remain unedited. This is how it works:

Teamwork Export
You can export all coded segments, memos, and variables of a text, an entire document group, or all documents by
right-clicking on the desired document group or document in the “Document System” and choosing Export teamwork from the context menu. The file can then be saved to a chosen spot. Teamwork exchange files have the extension MEX. This export file can now be transferred to others in the team (by E-mail, for example).
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Exchanging and comparing coded segments, memos, and variables

Codings, memos, external links and variables wilbe exported

Teamwork Import
It is recommended that you always create a project backup before importing teamwork, since this action cannot be
undone!
To insert a colleague’s team work, right-click on the document or document group that has been worked on and
choose Import teamwork from the context menu.
You have the option of selecting only particular elements out of the teamwork export file. You can choose which
exported text elements should be integrated into which target texts (this may be important in case you have identically named texts in your project file). You can also select the elements to be imported: variables, coded segments,
and/or memos. The default setting imports all elements. In order to be in control of the import procedures, it is recommended that you create a protocol file. This keeps track of which document has been imported with which
coded segments, memos, and variables. Coded segments will be listed with codes and subcodes, as well as paragraphs.
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The “Import teamwork” window

14.4Merging of projects
Merge your project “test project” with a second project by choosing Project > Merge projects from the main
menu bar. A dialog box pops up asking which project should be imported. This procedure adds all not yet available
memos, coded segments, codes, texts, and variables to your project.
Identical texts existing in both projects will be doubled during the merge procedure. If you want to avoid this, use
the style of teamwork mentioned beforehand or delete doubled documents by hand!
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Linking a Document to a Multimedia File

15 Audio/Visual files
MAXQDA was developed for use to analyze qualitative data with a focus specifically on text analysis. The fact that it
is now possible to analyze audio and video files in MAXQDA 10 does not mean that it is trying to replace or compete
with already-existent programs that specialize in video analysis (e.g. Studiocode and Transana). MAXQDA’s new
functionality for working with audio and video files is actually a simple extension of the text analysis options rather
than an attempt to offer a stand-alone video analysis tool. This was done in response to the common wish to have a
connection between text (usually interview transcripts) and the original audio or video files. For this reason, MAXQDA 10 makes it possible to make this connection between texts in RTF or DOC/X format and audio or video files
(MP3, WAV, etc.).
You can open any media file for which your computer has a codec. After selecting the file, the Document Browser
window will automatically be set to edit mode, so you can transcribe the text to the clip.
If you are having problems with playback of a certain file type, check out the Frequently Asked Questions on the
MAXQDA website.
There are three different ways to work with text and audio/video files:
Variation A – First you do the text transcription with whatever transcription software you want to use, import the
transcription as a document in MAXQDA, and then link the document to the original audio/video file. At this point,
there aren’t any connections between specific segments of the transcript and parts of the external file. These connections have to be created with time stamps within MAXQDA.
Variation B – The first step in this variation is to transcribe the file with the professional software f4
(www.audiotranscription.us), in which you can create time stamps as you transcribe. You can then export the transcript in RTF format and import it into MAXQDA, and the time stamps are imported along with the text. You will
then already have the connection between your text and the audio or video file.
Variation C – In this variation, you transcribe the file within MAXQDA.

15.1Linking a Document to a Multimedia File
To link a document in the Document Browser to a multimedia file, right-click on the document and click on Properties. The window that appears will include a field for a multimedia file. Click on the three dots to continue.

The media file field in the Properties window
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A dialog field will then appear, allowing you to choose the audio or video file that you want to link to. Once the
connection has been created, the document will be visualized in the Document Browser with a music note next to its
name: .
Tip: Audio and visual files are not actually imported into the .MX4 project file. They are simply linked to, so that the
project file size does not become unmanagable. It is therefore recommended that you keep all external (multimedia)
files in a single folder, and define that folder in the MAXQDA options menu Project > Options.

15.2The Media Player Toolbar
Before you can do the transcription as describe above, it is necessary to make sure the Media Player toolbar is being
displayed. You can access this toolbar from the Toolbars drop-down menu.

Activating the Media Player toolbar

You can then click on the red flag symbol

to activate the connection to the multimedia file:

Media Player toolbar

You will now see a new column in the Document Browser where the time stamps will be visualized. If you haven’t
created any yet, there will only be one at the very beginning of the document.

Time stamps are shown in a column between the text and the paragraph numbers

The symbols in the toolbar give you access to the following functions:
(De)activates the connection to the A/V file.

Transcribing Multimedia Files in MAXQDA
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Opens/closes the time stamp table.

Turns on/off sync mode, which causes the text to follow the media file.
Opens/closes the video window to view video files.
Inserts a new time stamp.
Rewinds the media file to the last time stamp.
Stops playback.
Pauses playback.
Fast forwards the media file to the next time stamp.
The two numbers next to the icons tells you the current point and the total length of the media file.

15.3Transcribing Multimedia Files in MAXQDA
MAXQDA offers several functions for simple transcription of multimedia files. To start a transcription, right-click on
the “Documents” icon in the Document System and choose Transcribe audio/video.

Acces the context menu by right-clicking on the “Documents” icon in the Document Browser
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A window will appear, allowing you to select the audio or video file that you want to transcribe. At the same time,
an empty document will be opened in the Document Browser with the Edit Mode turned on, so you can immediately begin to transcribe. If you haven’t done so yet, you will need to activate the Media Player toolbar, which can be
found in the “Toolbars” drop-down menu. To activate the media file, click on the red flag symbol.

The red flag symbol activates the connection to the media file

You can control the playback of the file with the F4 key (start/stop) and create time stamps with the F3 key (insert
time stamp). You only need to follow the following steps:
(1) Playback: Press the F4 key to play the file. It will continue until you click on the F4 key again to pause it.
(2) Transcribe: Now you can type into the document what you hear being said in the media file. As soon as you
start to transcribe, you’ll notice that a time stamp was inserted at the very beginning of the document (representing
the starting point 0:00).
(3) Insert time stamps: Only the first time stamp is inserted automatically. All others need to be created by you.
When you want to insert one, just hit the F3 key. It is up to you how often you insert new time stamps.
You can create more than one time stamp in the same line, but only one can be visualized in the time stamp column.
Once you are finished with the transcription, it can be coded in the same way as any other text-based document.

15.4Importing Transcripts with Time Stamps
This variation will be explained with a song as an example. Let’s say we wanted to have a synchronized connection
between the text and the audio for the song “I Want You” by Bob Dylan. To save us the time of doing the transcription, we can get the text from Dylan’s website. We can then either copy it and paste it into a document in MAXQDA, or we could paste the text into an RTF or DOC/X file and import that file into MAXQDA. For this example, we’ll
name the document “Dylan: I want you.” Once the text is in MAXQDA, we need to create the connection to the
audio file.
Right-click on the document “Dylan: I want you,” and select Properties from the context menu that appears.
Click in the field next to the “Media file” label in the “Multimedia” section. You will see a button with … on it just
to the right of the field. Clicking on that button will open up a window, so you can find the audio or video file (in
this case, the Bob Dylan song). Click Open.
Close the Properties window.
The MAXQDA document with the Dylan text is now linked to the audio file, but the audio file wasn’t actually imported as part of the MAXQDA project. You will now see that the symbol next to the “Dylan: I want you” document
has changed. This is the symbol for a document linked to a media file:

Double-clicking on this document opens it in the Document Browser (see below). A new column has been inserted
between the text and the paragraph numbers, which will show your time stamps. The document only has one time
stamp at this point, representing the very beginning of the song, since we haven’t added any yet. To play the song
with the internal media player, you need to activate the Media Player toolbar from the Toolbars drop-down menu.
You can then click on the red flag symbol in this toolbar to activate the media file.
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Importing F4 Transcripts with Time Stamps

Next, we would want to put the cursor at the beginning of the actual song text in paragraph 3, right before “The
guilty undertaker …” and start playback of the song. We can do this by clicking on the Play button or using the F4
key on the keyboard. We would then let the song go until right before the singing begins and insert a time stamp by
clicking on the “Insert time stamp” button or by pressing the F3 key. We want to do this same thing for the beginning of each verse. We would then see a time stamp symbol next to the first line of each verse.

We can now use the synchronized text and audio together. By clicking on any of the time stamps, we will hear the
song played from that point. If you do this with an interview transcript, you can in a similar way get back to various
sections that you may want to hear again for tone or emphasis.
If you turn on the Sync mode in the toolbar and click on the time stamp next to the first verse, the text follows the
song, meaning the section of text being sung will be highlighted, similar to the way karaoke works. You can then
follow along with the song text as you hear it.

15.5Importing F4 Transcripts with Time Stamps
The second variation saves you the trouble of creating time stamps in MAXQDA, because they were already created
in F4 and can simply be transferred over with the text to MAXQDA. Choose Import document from the Documents drop-down menu and select the RTF file that was generated by F4. MAXQDA then searches automatically for
a media file with the same name in that folder. It searches for files with typical media file formats like MP3, WAV,
MPEG, etc. If the transcript was called “Interview_06.rtf,” MAXQDA will look for “Interview_06.mp3,” “Inter-
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view_06.wav,” etc. If such a file is found, you just need to confirm that it is the appropriate file. If the file has a different name, you will need to find in the dialog window.
Tip: MAXQDA automatically checks whether the imported text document contains time stamps. If you want to import the media file with time stamps, it can only be done by importing the text file that has the time stamps imbedded in it. It is not possible to synchronize transcripts that have already been imported with external media files.
After you have imported the text and audio or video file, you will see the time stamps in a column just to the left of
the paragraph numbers in the Document Browser. The media file won’t be opened by MAXQDA, though, until you
open the Media Player toolbar and activate the media file by clicking on the red flag icon.

15.6The List of Time Stamps
You can see a list of all the timestamps and their details by clicking on the

icon.

The list of time stamps

The time stamps list has as many rows as there are time stamps in the document, and every row has three columns.
The first two columns contain the start and end points of that segment. In the third column, you have the option of
writing in a short comment about that particular segment. These columns are set up just like columns in any other
MAXQDA table. Clicking on any of the column headers sorts the table by that particular column alphabetically
(another click changes it to reverse alphabetical order). You also have the option to search in a column by rightclicking on the column header and selecting Search. If you don’t know if your search term is the first word in the
column, you can insert a “*” before your term. (A search for “*any” would find the word “company,” for example.)
If you are importing a document with time stamps, you still have the option to add new ones once it has been imported into MAXQDA. The option to write your comments in the list of time stamps also gives you a new way to
find sections of your media file. Double-clicking on a row takes you to that section of the text in the Document
Browser and starts playback of the media file from that point.

15.7Working with video
Video files are imported, heard, transcribed, and coded in the same way as audio files. The only difference is that the
file can be seen as well as heard by clicking on the Video window icon .
Clicking on timestamps takes you automatically to the appropriate point in the video.
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16 MAXMaps
MAXMaps offers a new perspective on your data and the connections within it. The primary task of MAXMaps is to
provide a graphical representation of the different elements within a MAXQDA project. These “objects” can be inserted into the MAXMaps drawing pads, and connections can be made in order to visualize a complex graph of relationships. MAXMaps also allows you to design graphical models or networks that are completely independent of
MAXQDA’s data. That’s why MAXMaps is a universal graphics software tool that is not only restricted to applications
in qualitative research within the social sciences. All elements of MAXQDA, e.g. codes, memos, coded segments,
and documents, may be imported into a map. In addition, MAXMaps also allows you to insert so-called free elements (text, pictures, and graphics) that can be chosen by the user.
MAXMaps can be used for different purposes. Maps can help to explore and organize data. They allow you to develop your ideas and to communicate them to your research team. Maps can also be a valuable tool for scientific explanation and can help to visualize complex relationships and theories. For instance, you can create tables and worksheets to gain a better perspective of the different elements within a project. MAXMaps can also be used for presentations and lectures. The different layers of a map may be displayed in arbitrary order; thus, a variety of different options for designing presentations are available.
With MAXMaps, it is possible to display:

 The relationships between different codes and categories.
 An overview of different facts and phenomena within the research field.
 The different memos belonging to a document or a group of documents.
 The context or important facts of the research, e.g. photographs of locations or persons.
 A graphical overview of the research methods used.
 A research timeline.
 The research design and characteristics of the sample.
MAXMaps can also have different functions for researchers. You can, for instance, use MAXMaps to organize and
manage your “Code System”. Or you can link codes, text, and memos in a hypothetical order to then further test
the relationships in a second step.
MAXMaps is not merely a graphics tool that works with icons and symbols, though. All the elements used in a map
are interactive, meaning they are connected to the MAXQDA project. Simply switch to “sync mode” to establish a
connection to the MAXQDA database. This makes an icon that symbolizes a text document not only a passive icon,
but allows you to double-click on the icon to open the document in MAXQDA’s “Document Browser.” Then you can
read and browse through the document. The same is true for memos. As soon as you click on the memo symbol,
the memo appears and can be read or even modified. In the case of symbols for coded segments, one click displays
the segment, which allows you to examine and compare different segments of your map.
MAXMaps allows you to define connections and relationships as you choose. These connections may be hypothetical
-- they do not even have to be consistent in logic while you are designing the maps because you are always free to
make changes. As a result, you can “play” with different models and relationships. For example, a code “attitude”
may appear as a condition of another code “behavior” in Map A and as the result of the code “behavior” in Map B.
Constructing, testing, and modifying different models is a an important aspect of analysis, thus making it counterproductive to be consistent with links and relationships right from the beginning.
MAXMaps not only allows you to define links and relationships, it also offers a way to make links and relationships
that have already been implemented in your project visible. Examples are memos that have been assigned to a document: MAXMaps can import all the connected memos automatically. These memos are displayed as symbols and
you can open and check them. The same is true for codes: If you have imported a code in your map, all the memos
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linked to this particular code can also be imported automatically. Moreover, you can search and insert all of the
codes overlapping with a code on your map and automatically connect them to the code.
These features do not establish new links or new relationships, but they allow for completely new perspectives to
your data. Connections that have likely been hidden in listings or tables can now come to the foreground. New
views and relationships become visually apparent and much easier to understand. The connections between different elements of the diagram are not restricted to hierarchical relationships as with the “Code System” in MAXQDA.
In MAXMaps, relationships can be represented in a more complex way, for instance as networks or any other type of
model.
This visual method of data display is supported by the variety and flexibility that characterizes MAXMaps. All elements used in a map may be designed individually. Codes, memos, and texts are not always displayed with the same
symbols and colors. You can select different symbols, colors, fonts, and sizes, or even import your own symbols
unique to each element of your map. All labels, images, and symbols can be managed individually. You can also import your own photographs, icons, or clip art.
An introduction to MAXMaps and an overview of all of its functions can be accessed by opening MAXMaps and
then clicking on the blue i symbol in the toolbar.

A map displays the relations between codes
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17 MAXDictio (Add-On)
MAXQDA users have repeatedly asked for a tool which would allow them to make an index of the words used in a
text, and so have access to an additional explorative aid for the evaluation of the text. As a dictionary and content
analysis module, MAXDictio makes it easy to explore the vocabulary used in a text as well as to find out which words
can be found in which text passages or texts. MAXDictio also enables users to analyse the differences in the vocabulary of the various texts of one project, e.g. the vocabulary used by your interviewees.
After the installation you will see in the familiar MAXQDA interface that the program has been supplemented by the
option MAXDictio next to the ? in the menu bar.
Clicking on MAXDictio opens a drop-down menu and you can select one of the options.

Starting MAXDictio

Besides the vocabulary functions, the MAXDictio module offers a number of techniques which have their origin in
the field of classical quantitative content analysis. MAXDictio does not intend to try to compete with software for
quantitative content analysis, but rather aims at utilising these techniques for qualitative data analysis and providing
these as an additional set of methods in a manageable form.
MAXDictio provides the following functions:

 Word frequency analyses in the whole text or in marked passages
 Word frequency analyses in text groups or in text sets which have been assembled based on textual criteria
 Free definition of text units (whereby these may overlap)
 Editing of texts and their assignment to text units, which is possible throughout the process
 Exportability of the results of the frequency analysis to Office programs (such as Excel or Word) and to SPSS, also
by using the Windows clipboard

 Index of selected words of one or more texts
 Possibility of jumping from an index entry to the text passage in which it is found
 Limitation of the analysis with Go-lists (which contain a list of the words that are to be analyzed) and Stop-lists
(which contain a list of those words that are to be excluded from the analysis)

 Selective analysis by predetermined criteria, such as the value of socio-demographic variables, and filtering by
numeric data

 Formation of word-based dictionaries
 Transfer of words from the word frequency table into the dictionary (simply by clicking on them)
 Export and import of dictionaries from Office programs (e.g. from Excel)
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 Coding on the basis of word-based dictionaries
 Results of the coder as editable and sortable Excel-like table
 Further processing of the results in SPSS and Excel
 Creation of a validation file for the verification of codes
 Total integration in the functionality of MAXQDA which provides convenient functions such as keyword-incontext or the automatic coding of text passages
The simplest function in MAXDictio determines the vocabulary of all texts of a current project.
This function can be accessed by

 either selecting the option Word frequencies in the MAXDictio menu
 or just clicking on the corresponding quick button in the toolbar.

Button for starting the word frequency function

Depending on the size of the project, it may take some time for MAXDictio to work through the material text by
text, as each word must be isolated, transferred into a list and counted.
What is a word in MAXDictio? A word is, as explained above, any sequence of letters between two delimiters. Delimiters can be spaces, tabs or punctuation marks. For example, “work.” as the last word of a sentence would be delimited by a space on its left and by a period on its right.
The table of results for the word frequency function looks as follows:

Results of word frequency count

The above table contains the following information:

 The number of analyzed texts (top left, here = 4)
 The total number of counted and separated words (i.e. “tokens”, here = 83,166)
 The number of different words in the texts (i.e. “types”, here = 3,685)
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The first column enables you to quickly exclude a word, to add it to the “Stop-list”. Double-clicking on it changes its
status. Words are initially on the “Go-list”. The depicted symbol is then green. When double-clicked, it changes into
a red stop sign.
In the next column are the words, such as they appear in the text. Whether the capitalization of words is displayed
or not depends on the selected option (in the Options menu).
The third column contains the word length counted in characters.
The fourth column contains the absolute frequency of each word in the searched texts.
The fifth column contains the ratio of the each word’s frequency to “tokens”, i.e. the total number of counted
words in all texts, expressed as a percentage. In our example the word “and” was counted 5421 times, which is
6.52 percent of the total of 83,166 words.
You have the following possibilities for handling the table:
An alphabetical list in ascending order is generated by clicking on the column title Word.
By clicking on the column header Word with the right mouse button, a shortcut menu can be opened which contains, among others, the option Search. This option opens a dialog box in which you can type the desired word.
A list of all positions of a word in the text can be created by clicking on the word with the right mouse button and
selecting the option Search results in the shortcut menu.
By double-clicking on a word it can be added to the active Stop-list.
For each word in the list of word frequencies, an index of the positions in the text where the words are found can be
created. Click on the desired word with the right mouse button; then select the function Search results from the
shortcut menu (see illustration below).

Shortcut menu in the word frequency table

In the illustration above, the word “god” was selected, which appeared exactly 320 times in the 4 texts.
The index which was created above appears as follows:
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List of all occurrences of a word in the texts

In the bar at the top of the window, the number of texts in which the word has been found is listed, as well as how
many times the word appears altogether, the “hits”.
The “Documents” column in the table indicates the name of the text group and of the text in which the word has
been found. In the column to the right the search item (here: “god”) is listed and in the third column the number of
the relevant paragraph in the text is shown.
This table can be sorted according to the data in each of the columns, just like in other tables in MAXQDA, either in
ascending or in descending order. Clicking once on the column title will sort the table by that column. By clicking on
the column title with the right mouse button you can open the shortcut menu, which, among other options, offers a
search within this column.
It is possible to limit the vocabulary analysis to activated texts. To analyse the vocabulary of one particular text, only
this one text must be activated. If more texts or a text group are to be analysed, these texts must be activated. With
the help of the Logical Activation function in MAXQDA, vocabulary analysis for certain groups of interviews can be
carried out. This function is called up by

 either selecting the option Count only dictionary words from the menu
 or by clicking on the appropriate button in the toolbar.

Button for word frequency in activated texts

Similar to when using the function Word frequencies, a certain amount of time may pass before all texts have been
worked through. The time needed is proportional to the amount of selected material which must be processed.
Again, all words are isolated, transferred into a list and counted. The results are displayed in a table as seen above, in
this case only for the activated texts.
MAXDictio enables you to set up Stop-lists. A “Stop-list” is a collection of “uninteresting” words, such as definite
and indefinite articles, conjunctions and numerals. Such words are usually sources of irritation when analysing a text.
For that reason, it is advisable to exclude them from the analysis. MAXDictio allows you to create as many “Stoplists” as you like, as well as to edit and manage them. Words which are in a stop-list will automatically be excluded
from the search results table.
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To create a “Stop-list”, you can either call up the option Stop-list in the MAXDictio menu or click on the button in
the MAXDictio toolbar.

Button for stop-lists

There are two different ways of adding words to a “Stop-list”:

 First, you can enter them manually by clicking on the button New at the top of the “Stop-list” window and then
typing in the word

 Second, you can select words from a word frequency list and add them to a “Stop-list” by double-clicking on
them. You can thus avoid having to type these words in. It is also possible to transfer several words into a “Stoplist” at once. To do so, mark all desired words. Then click on one of the words with the right mouse button and
select the option Add to stop-list.
The words in a stop-list are automatically listed in alphabetical order. This order is pre-set and cannot be modified.
Besides its vocabulary functions, the MAXDictio module has a function enabling coding using word-based dictionaries.
There are two ways of accessing the MAXDictio dictionary-function:

 through the menu MAXDictio and the option Dictionary
 through the button in the MAXDictio toolbar
A dictionary consists of categories and a list of search items which are allocated to each category.
A dictionary in MAXDictio can contain any number of categories. Exactly one list of search items belongs to each
category. The number of search items is not limited.
To add a new category, click on the button New category in the left window containing the list of all defined categories. Then a new category title can be entered. The title is not restricted to a certain length or form. It can also
consist of several words, such as “old-age pension”. The title of a category can be modified later without this having
an effect on the dictionary itself.

Setting up a dictionary

Initially, when clicking on New category, MAXDictio will add a category named “Category #”. Here the character #
stands for the sequential number of the category in the existing category system. This means that it always begins
with “Category 1”.
To add words belonging to a category, select the required category by clicking on it with the left mouse button.
Then click on New search item in the Search items window. Now it is possible to enter a new search item.
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Each category and each word belonging to a category can be turned on or off individually for the analysis. The procedure is the same as with the categories. The symbol next to each word indicates its state: green=on, red X=off.
Initially, each category (or word) is “on”, as indicated by a small green icon. Double-clicking on the icon it will
change into a red X. This indicates that the category (or word) will not be considered in the analysis.
Dictionaries may be saved and different dictionaries may be combined into one dictionary.
The MAXDictio coder automatically codes the texts on the basis of an active dictionary. It is important to understand
that the term “coding” in MAXDictio has a different meaning than the usual qualitative coding of text segments in
MAXQDA. Normally, coding in MAXDictio means that a text segment is assigned a code or subcode in the “Code
System”. The coding process in MAXDictio is no such assignment of codes to text sections, but rather the quantitative analysis of one or more texts on the basis of the categories and search items in a dictionary.
Thus the coding process of the coder corresponds to the approach in quantitative content analysis, in which the actual text is redundant and is substituted by counts of words and categories. To clarify this: in MAXQDA, qualitative
coding would mean, when coding the bible, for instance, to select a text section and then assign the code “Apostle
> Peter” to it. Then, by later activating this code, the corresponding passage could be found again. When working
with the MAXDictio coder, you would define the category “Apostle” with “Peter” as an attributed search item. Each
time the coder finds the search item, the frequency of the word and of the category is increased by one.
The result of such an analysis of the material with MAXDictio is a matrix which contains the frequencies of the categories.
The MAXDictio coder offers a variety of options that are described in the extended manual that is installed together
with the program.

